Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and operation of this equipment before you install, configure, operate, or maintain this product. Users are required to familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

---

**WARNING:** Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to personal injury or death, property damage, or economic loss.

**ATTENTION:** Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

**IMPORTANT** Identifies information that is critical for successful application and understanding of the product.

---

Labels may also be on or inside the equipment to provide specific precautions.

**SHOCK HAZARD:** Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may be present.

**BURN HAZARD:** Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach dangerous temperatures.

**ARC FLASH HAZARD:** Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).
## Table of Contents

### Preface
- Summary of Changes .............................................. 5
- Safety Information ............................................. 5
- Additional Resources ........................................... 6

### Chapter 1
**Product Overview**
- Introduction ...................................................... 7
- Printer ............................................................. 8
  - Connectors .................................................... 9
  - Rating Nameplate ............................................ 9
- Marker Cards .................................................... 10

### Chapter 2
**Setup**
- Unpacking ......................................................... 11
- Included Items .................................................. 11
- Installation Considerations ................................... 11
- Remove the Transport Restraints ............................ 13
- Install the Output Rail ......................................... 13
- Position the Touch Panel ...................................... 14
- Connect the Power Cable ...................................... 15
- Connecting the Printer ........................................ 16
- Turn the Printer On/Off ....................................... 16
- Choose the Touch Panel Language ......................... 17
- Install ClearTools Software .................................. 19
- USB Cable Connection ........................................ 23
- Running a Print Test .......................................... 25

### Chapter 3
**Operation**
- General Operation ............................................. 27
  - Inserting Marker Cards ..................................... 28
  - Processing a Single Marker Card .......................... 28
  - Processing a Stack of Marker Cards ..................... 29
- Software Setting ................................................ 29
  - Starting ClearTools ......................................... 29
  - Mapping and Calibrating the Printer ...................... 29
  - Assigning a Printer ......................................... 30
  - Printer Calibration .......................................... 32
  - Setting Material-dependent Slip ......................... 33
  - Adjusting Marker Cards .................................... 36
  - Printing Marker Cards ...................................... 40
  - Curing Settings / Heating level .......................... 40
  - Selecting the Print Quality ................................ 40
  - Touch Panel .................................................. 40
# Table of Contents

Menu Structure of the Touch Panel .......................... 41
Main Menu ....................................................... 42
Submenus ......................................................... 42
System Info ....................................................... 43
Changing the Printer Name ................................. 43
Changing the USB Port ....................................... 45
Ink Level ......................................................... 45
Protocol ........................................................... 46
Information ......................................................... 47
Tools ................................................................. 47
Print Jobs .......................................................... 48
Templates .......................................................... 48

## Chapter 4

### Cleaning and Maintenance

Tools Menu ......................................................... 49
  - Printhead Cleaning ........................................... 50
  - Printhead Flushing ........................................... 51
  - Executing a Sensor Check .................................. 51
Replacing Ink Cartridges ...................................... 52
  - Handling Ink Cartridges .................................... 52
  - Information on Inserting Ink Cartridges ................. 56
Replacing the Ink Collector .................................... 57
Cleaning the Printer Enclosure ............................... 59
Cleaning the Touch Panel ..................................... 59
Updating the Printer Software ................................ 59
Replacing the Service Kit ...................................... 60
Replacing Cleaning Fluid Bottle ............................. 69

## Chapter 5

### Troubleshooting

General Information ........................................... 71
List of Events .................................................... 72

## Chapter 6

### Specifications and Accessories

Technical Specifications ........................................ 75
Accessories ........................................................ 76
Summary of Changes

This publication contains new and updated information as indicated in the following table.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revised connection information, removed network cable connection option.</td>
<td>Throughout</td>
</tr>
<tr>
<td>Removed instructions on changing IP address/Subnet Mask/ Activating DHCP and Printing templates from a USB storage device.</td>
<td>Chapter 3</td>
</tr>
</tbody>
</table>

Safety Information

**WARNING:**
- Do not operate the printer without its cover and do not reach through its openings while it is running.
- Warning of hot surface: The curing process makes Marker Cards hot. Let Marker Cards cool off before removing them from the output rail.
- The openings in the enclosure of the printer must not be blocked or covered over.
- Do not insert any unintended objects through these openings.
- Make sure that no liquid gets into the printer.

**IMPORTANT**
- Do not power off the printer. The printer automatically goes into standby mode. The operating parameters are only retained while the printer is turned on. These parameters confirm, for example, that the printhead is cleaned optimally.
- If the printer is turned off or is not used, this can lead to blockage of the ink nozzles after some time.
- Print some Marker Cards every week. This is the only way to preserve print quality.
- Only remove ink cartridges when they are empty or have expired.
- Removing an ink cartridge can cause leaks in the connection between the ink cartridge and the ink line. This can lead to a faulty ink feed system.
- Do not use ink that has expired.
- When the ink expiration date is approaching, a message is displayed on the touch panel. Replace the specified ink cartridge (see section Replacing ink cartridges).
Additional Resources

These documents contain additional information concerning related products from Rockwell Automation.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ClearTools™ Software User Manual, publication 1492-UM009</td>
<td>Provides information to install and use ClearTools Software.</td>
</tr>
<tr>
<td>Industrial Automation Wiring and Grounding Guidelines, publication 1770-4.1</td>
<td>Provides general guidelines for installing a Rockwell Automation industrial system.</td>
</tr>
<tr>
<td>Product Certifications website: rok.auto/certifications</td>
<td>Provides declarations of conformity, certificates, and other certification details.</td>
</tr>
</tbody>
</table>

You can view or download publications at http://www.rockwellautomation.com/global/literature-library/overview.page.
Chapter 1

Product Overview

Introduction

The ClearMark™ Advanced ink jet printer is a printing system for labeling Allen-Bradley Marker Cards. The data is created using ClearTools™ labeling software. This software is also used for installing the printer driver.

This system can be used for the individual marking of equipment quickly and conveniently. The ClearMark Advanced uses heat-curing ink-jet printing to print Marker Cards for switching devices, machines, terminal blocks, cables, wires, and valves. A secure and permanent label is achieved through high-level resistance to smearing and scratching, UV-stability, and the high printing resolution for all markers. The ClearMark Advanced allows you to print small fonts. Even the smallest characters are easy to read, permitting you to increase the information density on the marker.

- The Marker Cards can be fed individually or inserted as stack of up to 30.
- The Marker Card that is fed into the printing unit is printed and then undergoes a heat curing cycle.
- Finally, the Marker Card is fed onto the output rail and can be removed.
- The Marker Card can be used immediately.
- The Marker Cards become hot due to the heat curing process. If necessary, let them cool down before removing them from the output rail.
- The ClearMark Advanced should not be powered off. If the ClearMark Advanced is not used, it automatically goes into standby/energy-saving mode. This optimizes the cleaning cycles and thus increases the availability of the printer.
Printer

Figure 1 - Front view of the printer

<table>
<thead>
<tr>
<th>Letter</th>
<th>Item</th>
<th>Letter</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Touch panel</td>
<td>C</td>
<td>Ink tank lid</td>
</tr>
<tr>
<td>B</td>
<td>Service cover</td>
<td>D</td>
<td>Output rail</td>
</tr>
</tbody>
</table>

Figure 2 - Rear view of the printer

<table>
<thead>
<tr>
<th>Letter</th>
<th>Item</th>
<th>Letter</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Filter cover</td>
<td>D</td>
<td>Stack input (loader)</td>
</tr>
<tr>
<td>B</td>
<td>Connectors</td>
<td>E</td>
<td>Cleaning fluid</td>
</tr>
<tr>
<td>C</td>
<td>Marker Card input</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 3 - Open ink tank lid

<table>
<thead>
<tr>
<th>Letter</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Ink cartridges</td>
</tr>
<tr>
<td>B</td>
<td>Ink Collector</td>
</tr>
<tr>
<td>C</td>
<td>Ink tank lid (open)</td>
</tr>
</tbody>
</table>
Connectors

Figure 4 - Connectors

<table>
<thead>
<tr>
<th>Letter</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Right-hand fuse (10 amperes)</td>
</tr>
<tr>
<td>B</td>
<td>Main power supply connection</td>
</tr>
<tr>
<td>C</td>
<td>Left-hand fuse (2.5 amperes)</td>
</tr>
<tr>
<td>D</td>
<td>USB port for connecting Personal Computer</td>
</tr>
</tbody>
</table>

Rating Nameplate

The rating plate contains information on the main voltage, article number, and serial number.

Figure 5 - Rating Nameplate
Marker Cards

Marker Cards made from plastic can be printed with the ClearMark Advanced printer.

The marking system, consisting of the ClearMark Advanced printer and the ClearTools software, has been designed by Rockwell Automation for Marker Cards.

- The Marker Cards can be inserted individually or in stacks.
- Marker Cards can be broken in half. To do this, bend the card in the middle.
- Complete and half Marker Cards should not be mixed in a stack.
- It is, however, possible to process different marker card types in a stack: for example, catalog numbers 1492-M5X5, 1492-M5X12, and 1492-M6X10.

Figure 6 - Marker Cards

<table>
<thead>
<tr>
<th>Letter</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Full Marker Card</td>
</tr>
<tr>
<td>B</td>
<td>Half Marker Card</td>
</tr>
</tbody>
</table>

Figure 7 - Description of the Marker Card

<table>
<thead>
<tr>
<th>Letter</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>First project marker surface</td>
</tr>
<tr>
<td>B</td>
<td>Marker area</td>
</tr>
<tr>
<td>C</td>
<td>Side strip</td>
</tr>
</tbody>
</table>
Chapter 2

Setup

Unpacking

1. Open the packaging.
2. Take out the accessories.
3. Lift the printer with the polystyrene packaging material from the box.
4. Remove the polystyrene packaging material.

**IMPORTANT**
- Because of its weight, use two people to carry the printer.
- Always hold the printer at the front and rear when carrying it.
- Always transport the printer in a horizontal position. If transported improperly, ink can escape and soil or damage the device.

**IMPORTANT**
Keep the original packaging for any future transport.

Included Items

When you have taken the ClearMark™ Advanced and all accessories out of the packaging, make sure that you have the following items:

- Power cable
- USB cable
- One box of catalog number 1492-M5X5 Marker Cards
- Output rail
- DVD with the ClearTools™ software
- Quick Start guide
- Ruler for calibration

Installation Considerations

Consider the following when installing the printer:

- Do not use the device near potential sources of electromagnetic interference, such as loudspeakers or the base stations of cordless telephones, as this can impair its function.
- Make sure that you provide the necessary operating and maintenance spaces.
- The printer must be placed on a flat, stable surface. The printer will not operate properly if it is tilted or at an angle.
• Avoid locations that are subject to strong fluctuations in temperature and humidity.
• Do not expose the printer to direct sunlight, strong light, or excessive heat.
• Avoid locations that are subject to impact shocks or vibrations.
• Do not use a table joined to other tables to avoid the transmission of vibration.
• Avoid installation sites that are subject to a large amount of dust.

1. Review the Installation Considerations.
2. Place the printer on a surface that extends beyond the base area of the printer on all sides.
3. Leave enough space in front of the output rail to allow the printer to output Marker Cards without interference.
4. Install the printer in such a way that it is sufficiently ventilated on all sides.
5. Install the printer near a power socket so that the plug can be readily removed in the event of a fault.

**Figure 8 - Operating and maintenance spaces**

<table>
<thead>
<tr>
<th>Letter</th>
<th>Clearance Distance mm (in.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>250 (9.84)</td>
</tr>
<tr>
<td>B</td>
<td>200 (7.87) output rail</td>
</tr>
<tr>
<td>C</td>
<td>100 (3.94)</td>
</tr>
<tr>
<td>D</td>
<td>250 (9.84)</td>
</tr>
<tr>
<td>E</td>
<td>100 (3.94)</td>
</tr>
</tbody>
</table>
Remove the Transport Restraints

1. Remove the transport restraints from the touch panel.
2. Remove the transport restraint from the ink tank lid.

Install the Output Rail

1. Install the output rail
2. Snap it into place.
Position the Touch Panel

The touch panel can be raised up to three rest positions. A click sound indicates that the touch panel is engaged in one of the rest positions. After a fourth click sound, the touch panel is unlocked and can be gently lowered down.

1. Raise the touch panel to the desired position.
2. Rotate the touch panel by its handle (A) to the required position.
Connect the Power Cable

**WARNING:**
- The supply voltage must match the voltage that is given on the printer rating nameplate.
- Only connect the device to a properly grounded and fused socket.
- Do not use a socket already being used by devices that are turned on and off at regular intervals, such as photocopiers or fans.
- Do not connect the printer to either a switch-operated or a timer-controlled power outlet.
- If you connect the ClearMark Advanced printer to the power supply via an extension cable, confirm that the total nominal current of all devices connected to the extension cable does not exceed the ampere rating for that extension cable.
- Make sure that the total nominal current of all devices that are connected to the wall socket does not exceed the ampere rating for that socket.
- When connecting the printer to the power supply, make sure that the building installation has an appropriate backup fuse.

**SHOCK HAZARD:**
- Warning of electrical hazard if the power cable is damaged. A damaged power cable can cause a fatal electric shock and lead to a fire.
- Do not place any objects on the power cable.
- Do not pull hard on the power cable and do not bend it any more than necessary.
- Failure to comply with these instructions can cause an electric shock or a fire.
- Insert the plug in a nearby socket and make sure that the socket is readily accessible.

**Figure 14 - Connecting the power cable**

1. Connect the power cable to the printer (A).
2. Verify that the plug is inserted firmly.
Connecting the Printer

The ClearMark Advanced is connected to a personal computer via USB cable.

Figure 15 - Connection

1. Turn on the printer by briefly holding down the on/off switch (A).

   **IMPORTANT**  
   Do not connect the USB cable until you have installed the ClearTools application software.

Turn the Printer On/Off

Figure 16 - Turning on the printer

1. Turn on the printer by briefly holding down the on/off switch (A).

   **IMPORTANT**  
   • Do not switch off the printer, the printer automatically goes into standby mode.
   • The operating parameters are only retained while the printer is turned on. These parameters confirm, for example, that the printhead is cleaned optimally.
   • Turning off the printer or not using it can cause blockage of the ink nozzles after a while.
   • Only turn the printer off to replace the service kit.
Choose the Touch Panel Language

When you start up the printer for the first time, a language choice is displayed on the touch panel.

Figure 17 - Touch panel - language choice

1. Press the desired language and press Save.

If the printer was turned off before you chose the language or if you want to change the language later, perform the following steps:

Figure 18 - Touch panel - main menu

2. From the main menu, press SYSTEM INFO.
3. Press LANGUAGE.

4. Press the desired language and press SAVE.
Install ClearTools Software

The marking system has been designed for the following operating systems:

- Microsoft Windows® 7 (32-bit/64-bit versions)
- Windows 8
- Windows 8.1
- Windows 10

**IMPORTANT** Administrator rights are required for installation.

You can find information about the application software in the ClearTools user manual, publication 1492-UM009.

1. Insert the supplied DVD in the personal computer DVD drive.
   The DVD starts automatically and the following screen appears
2. Click Software.

![Figure 21 - ClearTools Installation - Start menu](image)

3. Click ClearTools Software Installation.

![Figure 22 - ClearTools Installation - software](image)
The installation process starts automatically and the setup wizard appears.

4. Click Next.

**Figure 23 - ClearTools - setup wizard**

5. Accept the terms in the license agreement and click Next.

**Figure 24 - ClearTools - Accept the license terms**

6. Choose the setup type.
Figure 25 - ClearTools - Choose the setup type

<table>
<thead>
<tr>
<th>Installation Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typical</td>
<td>The ClearTools program is installed with the most common features.</td>
</tr>
<tr>
<td>Custom</td>
<td>The ClearTools program is installed; add-on modules can be selected/deselected.</td>
</tr>
<tr>
<td>Complete</td>
<td>The ClearTools program and all add-on modules are installed automatically.</td>
</tr>
<tr>
<td>Network</td>
<td>The ClearTools program is installed on a shared drive on the network and can be used by multiple users.</td>
</tr>
</tbody>
</table>

7. Click Typical.

Figure 26 - ClearTools - starting the installation process

8. Click Install.
   The installation process starts.
Figure 27 - ClearTools - status of the installation process

The installation status is shown by the progress bar.

Figure 28 - ClearTools - finishing the installation process

9. When the installation is completed, click Finish.
USB Cable Connection

**IMPORTANT** When you have installed the ClearTools application software, connect the USB cable to the printer. The printer driver is installed automatically.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>USB port</td>
</tr>
<tr>
<td>B</td>
<td>USB cable</td>
</tr>
</tbody>
</table>

1. To add the ClearMark Advanced, click Add.

**Figure 31 - Choosing printer connection**

2. Click USB.
   
The printer search starts.
Figure 32 - Printer search

The search result is displayed.

Figure 33 - Printer - search result

If no printer was found, you may start a new search process by clicking Search Again.

If a printer was found, click Add. The following dialog box appears:

Figure 34 - ClearMark Advanced Explorer

3. If you want to change the printer name, click Properties.
   This changed printer name is then displayed in ClearTools.

Figure 35 - Changing the printer name

4. Enter the printer name required for ClearTools, for example CMA Workplace 1 (USB1).

5. Confirm your inputs and click OK.
The changed name CMA Workplace 1 (USB1) is displayed in the Explorer.

Figure 36 - Changed printer name

You can remove the highlighted printer from the list by clicking Delete. You can add this printer again at any time. To exit the dialog box, click close. To check whether the printer that is highlighted in the list is connected and accessible, click Test. If successful, the following dialog box appears:

Figure 37 - Dialog box - connection test successful

You see the following message if the printer cannot be found because, for example, it is turned off:

Figure 38 - Dialog box - printer not found

Running a Print Test

When you have turned on the printer, run a print test.

Figure 39 - Touch panel - main menu

1. Press TEMPLATES on the touch panel main menu.
2. Choose a template that corresponds to the supplied Marker Card.

Figure 40 - Touch panel - Templates

3. Insert the marker card.

4. Press PRINT to run the print test.
Chapter 3

Operation

General Operation

**WARNING:**
- Do not operate the printer without its cover and do not reach through its openings while it is running.
- Warning of hot surface: The curing process makes Marker Cards very hot. Let Marker Cards cool off before removing them from the output rail.
- The openings in the enclosure of the printer must not be blocked or covered over.
- Do not insert any unintended objects through these openings.
- Make sure that no liquid gets into the printer.

**IMPORTANT**
- Do not power off the printer. The printer automatically goes into standby mode. The operating parameters are only retained while the printer is turned on. These parameters ensure, for example, that the printhead is cleaned optimally.
- If the printer is turned off or is not used, this can lead to blockage of the ink nozzles after some time.
- Print some Marker Cards every week. This is the only way to preserve print quality.
- Only remove ink cartridges when they are empty or have expired.
- Removing an ink cartridge can cause leaks in the connection between the ink cartridge and the ink line. This can lead to a faulty ink feed system.
- Do not use ink that has expired.
- When the ink expiration date is approaching, a message is displayed on the touch panel. Replace the specified ink cartridge (see section Replacing ink cartridges).
Inserting Marker Cards

Marker Cards can be inserted directly without any prior handling. The end with the solid margin must be fed into the printer.

Figure 41 - Direction of insertion for Marker Cards

Processing a Single Marker Card

Place the single Marker Card on the conveyor belt (A) in the direction of the arrow.

Figure 42 - Inserting a single Marker Card
Processing a Stack of Marker Cards

**IMPORTANT**
- Only Marker Cards are allowed to be inserted in stacks.
- You can insert a stack of up to 30 Marker Cards in the loader.
- The stack must not exceed 30 Marker Cards.
- The stack must not contain a mix of full-size and half-size Marker Cards.
- Insert the stack of Marker Cards in the loader (A) in the direction of insertion shown previously.

Software Setting

Starting ClearTools

1. Start ClearTools™ via the program icon on the desktop or via Start menu.

Mapping and Calibrating the Printer

A printer must be assigned for each Marker Card catalog number, for example: 1492-M5X5.

Calibration must be carried out once for the printer, as this is a printer-specific zero point.
Assigning a Printer

Figure 45 - Selecting a Marker Card

1. Choose for example, Marker Card>T erminal Markers.
2. Select the 1492-M5X5 Marker Card.
3. Click Select Product.
4. From the File menu, choose Print.

Figure 46 - Selecting the printer

5. Select the ClearMark™ Advanced printer that has been added.
6. Click Map.

Figure 47 - Mapping the printer

7. In the dialog box that follows choose As Printer and click OK.

Figure 48 - Assigning variants to the printer

8. In this dialog box choose whether you want to assign all variants of the 1492-M5X5 Marker Card to this printer.

If you click Yes, all versions of the Marker Card type 1492-M5X5 are assigned to the ClearMark Advanced and are always output on this printer unless this setting is changed.
Chapter 3  Operation

Printer Calibration

Figure 49 - Calibration

9. Click Calibration to determine the print position for the printer.

Figure 50 - Coordinate plane

10. Insert, for example, a 1492-M5X5 Marker Card in the printer (See Inserting Marker Cards on page 28).

11. Click Print Coordinate Plane.

12. Measure the X and Y values as shown below and enter them in the corresponding fields.
13. Enter the measured values in the Actual Width (X) and Actual height (Y) fields.
   In the example above the measured values are 209.5 x 46. The printer must output the rectangle 0.22% larger in order to reach the required output size.

14. To check the dimensions, insert a 1492-M5X5 Marker Card in the printer again.

15. Click the Print Adjusted Rectangle.

16. When the dimensions are correct, confirm your inputs with the OK.

The printer has now been adjusted for all Marker Cards.

17. Next set the material-dependent slip.

**Setting Material-dependent Slip**

The material-dependent slip correction must take place for every Marker Card version, as it must be set material dependently.

1. From the menu bar choose Tools > Printer Settings > Set Material-Dependent Slip...

2. Insert, for example, a 1492-M5X5 Marker Card in the printer (See Inserting Marker Cards on page 28).
Figure 52 - Setting Material-dependent Slip

3. Print to a rectangle of the specified size (210 x 48 mm) by clicking the Print Rectangle.

4. Remove the printed Marker Card from the printer.

5. Measure the size of the printed rectangle.
6. If the measured values differ from the specified size, enter these measured values in the Actual Width (X) and Actual height (Y) fields.

In the example above the measured values are 227 x 46. The printer must output the rectangle 0.44% larger in order to reach the required output size.

7. To check the dimensions, insert a 1492-M5X5 Marker Card in the printer again.

8. Click Print Adjusted Rectangle.

9. When the dimensions are correct, confirm your inputs with OK.

10. Next adjust the Marker Card type.
Chapter 3  Operation

Adjusting Marker Cards

Marker Cards may not be their normal size, for example as a result of the ambient temperature. It is generally the width that is affected by such a change. You can adjust Marker Cards to compensate for these physical changes. The adjustment must be set for every Marker Card type.

1. From the menu bar choose File>Adjust Marker Type...

Figure 54 - Adjusting the marker type

2. Measure the width (X) from the beginning of the first project marker to the beginning of the last project marker (see figure above).

3. To determine the height (Y), measure from the lower edge of the bottom marker to the upper edge of the top marker (see figure above).

4. Enter the actual measured values in the Width (X) and Height (Y) fields.

5. Enter the required values in the Offset (a) and Offset (b) fields to adjust the offset.
6. Insert, for example, a 1492-M5X5 Marker Card in the printer (See Inserting Marker Cards on page 28).

7. Click the printer icon:

The printed Marker Card looks like this:

Figure 56 - Marker Card

Three squares and one row of dots were printed on the Marker Card.

Example of an incorrect zero point in the X direction (offset a)
Figure 57 - Adjusting the Zero Point in the X Direction

In this example the three squares and the row of dots were printed 1 mm too far to the left.

To adjust this, it is necessary to change the value for Offset (a) in the Adjust Marker Type window (see Figure 54 on page 36).

In this example the squares have to be shifted to the right. Consequently a positive value must be entered (1 mm in this example).

Example of an incorrect zero point in the Y direction (offset b)

Figure 58 - Adjusting the Zero Point in the Y Direction

In this example the three squares and the row of dots were printed 1 mm too far up.

To adjust this, it is necessary to change the value for Offset (b) in the Adjust Marker Type window (see Figure 54 on page 36).

In this example the squares have to be shifted down. Consequently a positive value must be entered (1 mm in this example).

Example of an incorrect width X (adjusting the centering for all markers)
Figure 59 - Adjusting the Centering in the X Direction

From marker to marker, printing is increasingly shifting from the center to the right.

To adjust this, it is necessary to subtract the measured value (1 mm in this example) from the actual value for Width (X) in the Adjust Marker Type window (see Figure 54 on page 36).

If printing is increasingly shifting, from marker to marker, from the center to the left, it is necessary to add the measured value to the current value for 'Width (X)' in the 'Adjust Marker Type' window (see Figure 54 on page 36).

Example of an incorrect height Y (adjusting the centering for all markers)

Figure 60 - Adjusting the centering in the Y direction

From marker to marker, printing is increasingly shifting from the center upward.

To adjust this, it is necessary to subtract the measured value (1 mm in this example) from the current value for Height (Y) in the Adjust Marker Type window (see Figure 54 on page 36).

If printing is increasingly shifting, from marker to marker, from the center downward, it is necessary to add the measured value to the current value for Height (Y) in the Adjust Marker Type window (see Figure 54 on page 36).
Printing Marker Cards

1. Start the ClearTools software.
2. Select the required Marker Card.
3. Enter the text or insert an image or barcode that you want to print.
4. Insert the Marker Card or the Marker Card stack.
5. Start printing via ClearTools.

Curing Settings / Heating level

The settings for curing Marker Cards differ and are applied automatically.

It is possible to set a higher or lower intensity for curing. Details on fine adjustment of the heating level can be found in the ClearTools user manual.

After cooling, check each Marker Card for resistance to smudging and scratching.

Selecting the Print Quality

It is possible to determine the print quality. Details on this process can be found in the ClearTools user manual.

Touch Panel

The touch panel enables you to look up information about the printer such as the current ink level in the cartridges, view and delete print jobs and carry out maintenance. You can also set the required language for the touch panel and print out sample templates.

The touch panel displays prompts to change the ink cartridges and to maintain the printer.

The touch panel can be raised and rotated to the position you require (See Position the Touch Panel on page 14).
Menu Structure of the Touch Panel

![Diagram of the menu structure of the Touch Panel]

- **TEMPLATES**
  - Templates
  - Print
  - USB

- **PRINT JOBS**
  - Overview
  - Edit

- **TOOLS**
  - Printhead cleaning
  - Printhead flushing
  - Sensor check

---

**SYSTEM INFO (Page 1)**

- Printer name
- IP address
- Language
- USB port

- Change printer name
- Change IP address
- Change subnet mask
- Activate/Deactivate DHCP

---

**SYSTEM INFO (Page 2)**

- Ink fill level
- Protocol
- Information

- Select color
- Overview of events
- Information about ClearMark™ Advanced

- Information of ink
- Message and proposed solution

- Message information
Main Menu

The printer status is shown in the bottom line. In the example above the printer is Ready.

From the main menu, choose the appropriate sub menu: TEMPLATES, PRINT JOBS, TOOLS and SYSTEM INFO.

The bottom part of the main menu shows the ink level of the individual cartridges. You can find exact details of the ink level under SYSTEM INFO in the second window (See System Info on page 43).

Submenus

Others are available in the submenus:

- Displays the next page.
- Displays the previous page.
- Takes you back to the main menu.
- The currently selected menu, for example System Info, is shown at the top of the touch panel.
System Info

1. Press SYSTEM INFO on the touch panel's main menu.

Figure 62 - Touch Panel - System Info 1

Figure 63 - Touch Panel - System Info 2

The following sections provide more information about the individual menu items.

Changing the Printer Name

The preset printer name is always the serial number. You can assign a self-explanatory name to the printer to be able to identify it better. Follow these steps:

1. In the first System Info window, press PRINTER NAME.
2. Enter the desired printer name via the on-screen keys and press SAVE.
   To delete entire entry, press X.
   To enter a space character, press Space
3. In this window you can enter the required data via the numeric keys. You can delete the entire entry with the [X] key.

4. Save your inputs by pressing SAVE.

5. It may be necessary to restart the printer (if so, a message is then displayed on the touch panel).
Changing the USB Port

Whenever a printer is installed via a USB port, USB - 001 is assigned to it. If you connect a second printer to the PC, USB - 001 is automatically assigned to this printer, too. A different USB port must therefore be assigned manually to the second printer, e.g. USB - 002 or USB - 003. Proceed as follows to make this change:

1. In the first System Info window, touch the [USB PORT].

Figure 66 - Touch Panel - System Info - USB port

![USB Port Selection](image)

2. Select the desired USB port and press SAVE.

Ink Level

Press INK LEVEL to display information about the ink cartridge.

1. In the second System Info window, press INK LEVEL.

Figure 67 - Touch Panel - System Info - Ink Level

![Ink Level Screen](image)

2. If you enter the respective color, a window opens with further information about the selected ink cartridge.
Figure 68 - Touch Panel - System Info - Information of Ink

Protocol

Press PROTOCOL to display an overview of printer events.

1. In the second System Info window, press PROTOCOL.

Figure 69 - Touch Panel - System Info - Protocol

The window shows the error messages of the last 4 weeks.
Information

1. In the second System Info window, press INFORMATION.

![Figure 70 - Touch Panel - System Info - Information](image)

Information about the ClearMark Advanced is displayed here, e.g. which firmware version is currently in use or how many Marker Cards have been printed.

Tools

Press TOOLS on the main menu to carry out the following maintenance tasks.

![Figure 71 - Touch Panel - Tools](image)

You will find a description of the individual maintenance tasks in Chapter 4.
Print Jobs

1. Press PRINT JOBS on the main menu, to display the print jobs in the queue.

   Here you can also delete print jobs if, for example, the wrong file was sent to the printer.

![Figure 72 - Touch Panel - Print Jobs](image)

This window shows all pending print jobs.

1. Select the print job that you want to delete by touching it.
2. Press EDIT to stop the printer.
3. Press DELETE.

   A print job that has already started cannot be deleted. The power cable must not be disconnected during printing.

Templates

1. Press TEMPLATES on the touch panel's main menu.

![Figure 73 - Touch Panel Templates](image)

Under TEMPLATES you will find sample templates, for example for printing tests.

2. Select the template that you want to print.
3. Insert the corresponding Marker Card in the printer.
4. Press PRINT to execute the print job.
Chapter 4

Cleaning and Maintenance

Tools Menu

Figure 74 - Touch Panel - Main Menu

1. Press TOOLS in the main menu.
   The following screen is then displayed:

Figure 75 - Touch Panel - Tools
Printhead Cleaning

Figure 76 - Printhead cleaning

Carry out printhead cleaning if the print quality deteriorates.

1. Press TOOLS in the main menu.
2. Press HEAD CLEANING in the Tools menu.

Figure 77 - Touch Panel - Printhead Cleaning

3. Press NO if printhead cleaning should not be executed
4. Press YES if printhead cleaning should be executed:

   Printhead cleaning takes approx. 2 minutes. The following message is displayed on the touch panel during printhead cleaning:

Figure 78 - Touch Panel - Printhead Cleaning Duration

5. Print out a Marker Card. If the printing result is still not satisfactory, execute printhead flushing.
**Printhead Flushing**

If you have carried out printhead cleaning and the printing result is still not satisfactory, execute printhead flushing. With printhead flushing, considerably more ink is used than with printhead cleaning.

1. Press TOOLS in the main menu.
2. Press HEAD FLUSHING in the Tools menu.

*Figure 79 - Touch Panel - Printhead Flushing*

![Printhead Flushing](image)

3. Press NO if printhead flushing should not be executed:
4. Press YES if printhead flushing should be executed:

   Printhead flushing takes approx. 5 minutes. The following message is displayed at the touch panel:

*Figure 80 - Touch Panel - Printhead Flushing Duration*

![Printhead Flushing Duration](image)

**Executing a Sensor Check**

In a sensor check, all sensors in the printer are checked to make sure they are functioning. If a sensor is soiled, for example, it cannot detect when a Marker Card passes through.

1. Insert a Marker Card in the printer.
2. Press TOOLS in the main menu.
3. Press SENSOR CHECK in the Tools menu.
4. Press NO if a sensor check should not be executed:

5. Press YES if a sensor check should be executed:

All sensors in the system are now checked. The following window is displayed during this time:

![Figure 81 - Touch Panel - Execute Sensor Check](image)

A status page is subsequently displayed which presents the sensors and shows whether they are correct or not.

Contact a service technician in case of an error.

**Replacing Ink Cartridges**

Replace the ink cartridges when they are empty or their expiration date has been reached.

**Handling Ink Cartridges**

Observe the following information when replacing ink cartridges:

- The ink cartridges are sealed units. Under normal circumstances, ink will not leak out of an ink cartridge. Do not try to disassemble or try to refill ink cartridges.
- Always handle used ink cartridges with care as ink can be in the ink supply outlet. Do not shake ink cartridges, as this may cause ink to leak.
- If you get ink on your hands, wash them thoroughly with soap and water. If you get ink in your eyes, rinse immediately with plenty of water.
• If you accidentally swallow any ink, rinse out your mouth and drink plenty of water. Do not induce vomiting.
• When the use-by date of the ink approaches (printed on the packaging), a message is displayed at the touch panel. Replace the specified ink cartridge. Use all the ink in the ink cartridge by the date stated on the label to achieve the best print results.
• Using expired ink reduces the print quality and can cause damage to the printer. Damages due to the use of out-of-date ink cartridges are excluded from the warranty.
• Store unopened ink cartridges in a cool and dry place, preferably in a refrigerator at about 4 °C.
• Before using an ink cartridge that has been stored in a colder place, allow the cartridge to stand at room temperature for at least three hours.
• Install ink cartridges in the printer immediately after removing them from the packaging. The print quality can be impaired if an ink cartridge is left unpacked for any length of time before use.
• Ink is used when a new ink cartridge is inserted or when the ink tank lid is opened, as the printer always carries out a reliability check.

The ink filling level can be displayed at the touch panel; if necessary, replace the ink cartridges.

1. Press SYSTEM INFO in the main menu.
2. Change to the second page of the System info
3. Press INK LEVEL.

Figure 83 - Touch Panel - System Info - Ink Level

If the expiration date of an ink cartridge has been reached, a message is automatically displayed on the touch panel.
Important components can become blocked and the printer may be damaged if you press YES and continue to print with the out-of-date ink cartridge. Damages due to the use of out-of-date ink cartridges are excluded from the warranty. Therefore, replace out-of-date ink cartridges immediately! (Also see information shown via PLEASE NOTE)

4. Press NO

5. Replace the ink cartridge.

The following information is displayed after pressing INFORMATION:

**Figure 85 - Touch Panel - Note: Ink Expired**

**IMPORTANT** If you open the ink tank lid, the printer will stop.
Figure 86 - Opening the Ink Tank Lid

1. Open the ink tank lid by pressing the finger recess (A).

Figure 87 - Removing the Ink Cartridge

2. Remove the ink cartridge which must be replaced by extracting it horizontally.
Information on Inserting Ink Cartridges

The ink cartridges are electronically and mechanically coded, ensuring they can only be inserted correctly.

Figure 88 - Coding of the ink cartridges

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Electronic coding</td>
</tr>
<tr>
<td>B</td>
<td>Mechanical coding</td>
</tr>
</tbody>
</table>

Figure 89 - Positions of the ink cartridges

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Black ink cartridge (K)</td>
</tr>
<tr>
<td>B</td>
<td>Cyan ink cartridge (C)</td>
</tr>
<tr>
<td>C</td>
<td>Magenta ink cartridge (M)</td>
</tr>
<tr>
<td>D</td>
<td>Yellow ink cartridge (Y)</td>
</tr>
</tbody>
</table>
3. Remove the ink cartridge from its packaging.

*Figure 90 - Inserting an ink cartridge*

4. Insert the ink cartridge into the printer. The ink cartridge is properly inserted when it snaps into place.

**Replacing the Ink Collector**

Replace the ink collector if a touch panel message displays that it is full.

Proceed as follows for more information:

1. Press OK.

*Figure 91 - Error message - ink collector*

**IMPORTANT**

- Do not open the ink collector. The complete tray must be replaced.
- Dispose of the ink collector through an authorized dealer or at a suitable hazardous materials disposal center. Check local regulations before attempting to dispose of the ink collector yourself.
- If you open the ink tank lid, the printer stops.
1. Open the ink tank lid by pressing the finger recess (A).

2. Press the interlock (B) downwards

3. Remove the ink collector (C).

4. Insert the new ink collector horizontally.
Cleaning the Printer Enclosure

**SHOCK HAZARD:** When cleaning the printer, ensure that no moisture enters it.

- Only clean the printer enclosure. Only service technicians should clean the inside of the printer.
- Keep moisture away from live parts as it can cause short-circuits.

**IMPORTANT**

Regularly clean the outside of the printer enclosure using a soft, dry or slightly moistened wipe.

Do not use volatile chemicals such as benzene, thinning fluid or insecticide on the printer. The use of such chemicals can result in damage to the printer including cracks or color changes.

If the dirt does not come off, initially wipe the printer with a wipe moistened with a neutral cleaning agent, then with a moist cloth, and finally with a dry cloth.

Cleaning the Touch Panel

Clean the touch panel with a cleaning agent suitable for touch screens and a soft, lint-free cloth.

Updating the Printer Software

Proceed as follows to update the printer software:

1. Start the ClearTools™ program.
2. In ClearTools, choose Tools, then Options.
3. In the Options window, choose the entry ClearMark™ Advanced and then Administration.

*Figure 95 - ClearTools - updating the printer software*
4. Select the update file, in the example above it is the ‘update.zip’ file.
5. Click on the [Start printer update] and the following message is displayed.

Figure 96 - ClearTools - updating the printer software

![Figure 96 - ClearTools - updating the printer software](image)

6. Confirm the message, click YES.
   A successful software update is displayed on the touch panel of the printer.
7. Press OK to confirm it at the touch panel of the printer.

Replacing the Service Kit

If the print quality is no longer satisfactory, try cleaning the print head. If the quality does not improve, replace the service kit. See Accessories on page 76.

1. Disconnect the printer from power source.
2. Open the service cover.

Figure 97 - Unlocking the service cover

![Figure 97 - Unlocking the service cover](image)

3. Insert a flat-blade screwdriver in the lock (A) and unlock the service cover (B).
4. Open the service cover (A) and detach it.

5. Disconnect the connectors (A) and (B).

Before you can remove the service kit, put the printhead in the unlocking position.
6. Insert a screwdriver in the printhead release (A) and turn the printhead (B) 90° counterclockwise so that it reaches the unlocking position.

7. Remove the service kit’s retaining screw (C).

**IMPORTANT** Turn the printhead just 90° counterclockwise. Turning it clockwise will ruin the mechanism.
8. Slightly raise the injector (A) to remove it from the catch.

9. Remove the service kit’s retaining screws (A) and (B).

**IMPORTANT** Put on the disposable gloves. 
Hold the service kit as level as possible when removing.
10. Pull out the service kit (A) carefully.

**IMPORTANT** The service set contains two wipes to clean the two printheads. To clean the printheads properly, use a separate/new wipe service kit for each printhead.

11. Clean printhead A with one of the wipes provided.
Figure 106 - Cleaning printhead B

12. Clean printhead B with the second wipe provided.

Figure 107 - Pushing in the service kit

14. Fasten the service kit with the screws (A) and (B).

Figure 109 - Fastening the injector

15. Reattach the injector (B) carefully and fasten it with the screw (A).
16. Reconnect the connectors (A) and (B).

17. Reattach the service cover (A) and close it.
18. Insert a flat-blade screwdriver in the lock (A) and lock the service cover (B).

19. Reconnect the printer to power (see Connect the Power Cable on page 15) Turn the printer back on (see Turn the Printer On/Off on page 16).
Replacing Cleaning Fluid Bottle

Replace cleaning fluid bottle if it is empty. See Accessories on page 76

Figure 113 - Removing the hood

1. Detach the hood (A) over the cleaning fluid bottle (B).

Figure 114 - Unscrewing the bottle out of the top

2. Unscrew the empty bottle (A) out of the top.
3. Screw a full cleaning fluid bottle (A) into the top.

4. Reattach the hood (B) over the cleaning fluid bottle (A).
Troubleshooting

General Information

A message on the touch panel indicates a printer fault or when an ink cartridge needs to be replaced.

Touch the [SYSTEMINFO] in the main menu of the touch panel for more detailed information about this message and to see which measures should be taken. Change to the second page of the System Info and touch the [PROTOCOL]. The event is displayed. Use the [DETAILS] to display further information and an appropriate proposed solution.

**EXAMPLE**  The printing results are unsatisfactory. The printed image is too weak or is spotted. Check the printer status.

<table>
<thead>
<tr>
<th>Printer Status</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Has the printer not been used for a long time?</td>
<td>The ink might have dried up or the printhead nozzles are blocked. If necessary, clean the printhead. See Printhead Flushing on page 51</td>
</tr>
<tr>
<td>Is the printed image unclear or doubled?</td>
<td>In this case, contact Rockwell Automation Technical Support</td>
</tr>
<tr>
<td>Is there a problem with the printer's location?</td>
<td>Make sure that the printer is located on a flat even surface. Install the printer at a site that is free from vibration</td>
</tr>
<tr>
<td>A Marker Card is stuck in the printer</td>
<td>Power off the printer and then power it back on again. The card stuck in the printer will be fed out</td>
</tr>
<tr>
<td>The print is irregular, either too strong or too weak</td>
<td>Check the following if there is a problem with the print quality, such as irregular print or inappropriate ink quantity: Are you using an out-of-date ink cartridge? Using expired ink reduces the print quality and can cause damage to the printer</td>
</tr>
<tr>
<td>The printouts are dirty or spotted</td>
<td>Have you touched the unprinted marker areas of the Marker Card? Do not touch the unprinted marker area</td>
</tr>
<tr>
<td>Opening the ink tank lid during the print process</td>
<td>Printing is canceled if the ink tank lid is opened during the printing process. If you open the lid before the heating unit has switched on, the printing process will resume as soon as the lid is closed. If you open the lid while the heating unit is already activated, the heating unit will switch off. The current Marker Card will be printed and fed out of the printer without fixation. A message is displayed on the touch panel. The filling level of the ink cartridges is set to 'empty'. The printer automatically starts re-initialization of the ink tank system (takes up to 2 minutes).</td>
</tr>
<tr>
<td>Are the Marker Cards aligned correctly?</td>
<td>Check the alignment of the inserted Marker Card</td>
</tr>
<tr>
<td>Are you using an original Rockwell Automation® ink cartridge?</td>
<td>Only use original Rockwell Automation ink cartridges. The printer may be damaged if you are not using an original Rockwell Automation ink cartridge or if you are using a refilled cartridge.</td>
</tr>
</tbody>
</table>

Rockwell Automation Publication 1492-UM011D-EN-P - February 2020
## List of Events

<table>
<thead>
<tr>
<th>Code</th>
<th>Event</th>
<th>Measure</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>30019</td>
<td>Left internal ink collector unit is nearly full.</td>
<td>Please contact your Rockwell Automation representative to ensure the operating status.</td>
<td>Unlike the ink collecting tray that can be replaced easily by the user, the internal ink collector unit is firmly fitted and can therefore only be replaced by a service technician. If the internal ink collector unit is full, the printer stops the operation in order to prevent print system malfunctions. Only qualified service technicians should replace components inside the device.</td>
</tr>
<tr>
<td>30021</td>
<td>Right internal ink collector unit is nearly full.</td>
<td>Please contact your Rockwell Automation representative to ensure the operating status.</td>
<td>Unlike the ink collecting tray that can be replaced easily by the user, the internal ink collector unit is firmly fitted and can therefore only be replaced by a service technician. If the internal ink collector unit is full, the printer stops the operation in order to prevent print system malfunctions. Only qualified service technicians should replace components inside the device.</td>
</tr>
<tr>
<td>10032</td>
<td>Ink collecting tray is nearly full.</td>
<td>Make sure that a new ink collecting tray is available. Catalog number 1492-PCMAINK.</td>
<td>To avoid waiting due to a full ink collecting tray, you should make sure that you always have a new ink collecting tray available.</td>
</tr>
<tr>
<td>10072</td>
<td>The BLACK ink cartridge (K) is nearly empty.</td>
<td>The ink cartridge is nearly used up. Make sure that a new ink cartridge is available. Catalog number 1492-PCMAINK-K.</td>
<td>If the ink cartridge is empty, the printer stops the operation in order to prevent print system malfunctions.</td>
</tr>
<tr>
<td>10073</td>
<td>The CYAN ink cartridge (C) is nearly empty.</td>
<td>The ink cartridge is nearly used up. Make sure that a new ink cartridge is available. Catalog number 1492-PCMAINK-C.</td>
<td>If the ink cartridge is empty, the printer stops the operation in order to prevent print system malfunctions.</td>
</tr>
<tr>
<td>10074</td>
<td>The MAGENTA ink cartridge (M) is nearly empty.</td>
<td>The ink cartridge is nearly used up. Make sure that a new ink cartridge is available. Catalog number 1492-PCMAINK-M.</td>
<td>If the ink cartridge is empty, the printer stops the operation in order to prevent print system malfunctions.</td>
</tr>
<tr>
<td>10075</td>
<td>The YELLOW ink cartridge (Y) is nearly empty.</td>
<td>The ink cartridge is nearly used up. Make sure that a new ink cartridge is available. Catalog number 1492-PCMAINK-Y.</td>
<td>If the ink cartridge is empty, the printer stops the operation in order to prevent print system malfunctions.</td>
</tr>
<tr>
<td>30626</td>
<td>The cleaning procedure failed.</td>
<td>Replace the ink cartridge if necessary. Restart the printer.</td>
<td>If the message is displayed again, please contact your Rockwell Automation representative.</td>
</tr>
<tr>
<td>40012</td>
<td>The expiry date for BLACK (K) has passed.</td>
<td>Replace the BLACK ink cartridge (K). Catalog number 1492-PCMAINK-K.</td>
<td>Rockwell Automation urgently recommends that you do not continue to print with inks that have expired, as this can damage the printer. To continue printing, click on [Notes] and confirm that you wish to continue on the next screen. Each ink cartridge has an expiry date. This helps to protect the print system and to maintain consistent labeling quality. Once the expiry date has passed, the properties of the ink deteriorate. Important components can be clogged and cause permanent damage to the printer.</td>
</tr>
<tr>
<td>40013</td>
<td>The expiry date for CYAN (C) has passed.</td>
<td>Replace the CYAN ink cartridge (C). Catalog number 1492-PCMAINK-C.</td>
<td>Rockwell Automation urgently recommends that you do not continue to print with inks that have expired, as this can damage the printer. To continue printing, click on [Notes] and confirm that you wish to continue on the next screen. To minimize the risk of damage to the device, the device automatically performs additional cleaning procedures once the expiry date has passed. This can also increase the consumption of inks that have not expired. Rockwell Automation recommends that you always replace expired ink cartridges immediately. Rockwell Automation shall not accept any responsibility for the quality or reliability of expired ink cartridges. Servicing or repairs to the device that are necessary as a result of expired ink cartridges are excluded from the warranty.</td>
</tr>
<tr>
<td>40014</td>
<td>The expiry for MAGENTA (M) has passed.</td>
<td>Replace the MAGENTA ink cartridge (M). Catalog number 1492-PCMAINK-M.</td>
<td>Rockwell Automation urgently recommends that you do not continue to print with inks that have expired, as this can damage the printer. To continue printing, click on [Notes] and confirm that you wish to continue on the next screen.</td>
</tr>
<tr>
<td>40015</td>
<td>The expiry date for YELLOW (Y) has passed.</td>
<td>Replace the YELLOW ink cartridge (Y). Catalog number 1492-PCMAINK-Y.</td>
<td>Rockwell Automation urgently recommends that you do not continue to print with inks that have expired, as this can damage the printer. To continue printing, click on [Notes] and confirm that you wish to continue on the next screen.</td>
</tr>
<tr>
<td>Code</td>
<td>Event</td>
<td>Measure</td>
<td>Information</td>
</tr>
<tr>
<td>--------</td>
<td>----------------------------------</td>
<td>----------------------------------------------</td>
<td>--------------------------------------------------------------</td>
</tr>
<tr>
<td>40002</td>
<td>Faulty BLACK ink cartridge (K).</td>
<td>Restart the printer</td>
<td>Only use original ClearMark™ Advanced ink cartridges.</td>
</tr>
<tr>
<td>40003</td>
<td>Faulty CYAN ink cartridge (C).</td>
<td>Restart the printer</td>
<td>Only use original ClearMark Advanced ink cartridges.</td>
</tr>
<tr>
<td>40004</td>
<td>Faulty MAGENTA ink cartridge (M)</td>
<td>Restart the printer</td>
<td>Only use original ClearMark Advanced ink cartridges.</td>
</tr>
<tr>
<td>40005</td>
<td>Faulty YELLOW ink cartridge (Y)</td>
<td>Restart the printer</td>
<td>Only use original ClearMark Advanced ink cartridges.</td>
</tr>
<tr>
<td>40205</td>
<td>The ink tank cover is open.</td>
<td>Close the ink tank cover</td>
<td>Please contact your Rockwell Automation representative</td>
</tr>
<tr>
<td>40101</td>
<td>No ink cartridges have been</td>
<td>Insert the ink cartridges and make sure</td>
<td>Please contact your Rockwell Automation representative</td>
</tr>
<tr>
<td>40172</td>
<td>Faulty BLACK ink cartridge (K).</td>
<td>Restart the printer</td>
<td>Only use original ClearMark Advanced ink cartridges.</td>
</tr>
<tr>
<td>40173</td>
<td>Faulty CYAN ink cartridge (C).</td>
<td>Restart the printer</td>
<td>Only use original ClearMark Advanced ink cartridges.</td>
</tr>
<tr>
<td>40174</td>
<td>Faulty MAGENTA ink cartridge (M)</td>
<td>Restart the printer</td>
<td>Only use original ClearMark Advanced ink cartridges.</td>
</tr>
<tr>
<td>40175</td>
<td>Faulty YELLOW ink cartridge (Y)</td>
<td>Restart the printer</td>
<td>Only use original ClearMark Advanced ink cartridges.</td>
</tr>
<tr>
<td>40030</td>
<td>Faulty ink collecting tray.</td>
<td>Restart the printer</td>
<td>Only use original ClearMark Advanced ink cartridges.</td>
</tr>
<tr>
<td>40159</td>
<td>The ink collecting tray was not</td>
<td>Insert the ink collecting tray correctly and</td>
<td>If the message is displayed again, please contact your</td>
</tr>
<tr>
<td></td>
<td>inserted correctly.</td>
<td>make sure that it is fully engaged. Restart</td>
<td>Rockwell Automation representative if the error persists.</td>
</tr>
<tr>
<td>40904</td>
<td>The temperature is too high.</td>
<td>Wait a while until the printer has</td>
<td>If the message is displayed again, please contact your</td>
</tr>
<tr>
<td>40905</td>
<td>The temperature is too low.</td>
<td>wait a while until the printer has</td>
<td>If the message is displayed again, please contact your</td>
</tr>
<tr>
<td>10044</td>
<td>The temperature is too low.</td>
<td>Wait a while until the printer has</td>
<td>If the message is displayed again, please contact your</td>
</tr>
<tr>
<td>10045</td>
<td>The temperature is too high.</td>
<td>Wait a while until the printer has</td>
<td>If the message is displayed again, please contact your</td>
</tr>
</tbody>
</table>
### Chapter 5  Troubleshooting

<table>
<thead>
<tr>
<th>Code</th>
<th>Event</th>
<th>Measure</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Internal error</td>
<td>Restart the printer.</td>
<td>If the message is displayed again, please contact your Rockwell Automation representative.</td>
</tr>
<tr>
<td>60005</td>
<td>Transport timeout</td>
<td>Restart the printer.  Carry out a sensor test.</td>
<td>The marker was not transported within the defined time.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>If the message is displayed again, please contact your Rockwell Automation representative.</td>
</tr>
<tr>
<td>60006</td>
<td>Internal error</td>
<td>Restart the printer.</td>
<td>If the message is displayed again, please contact your Rockwell Automation representative.</td>
</tr>
<tr>
<td>60007</td>
<td>Faulty ink cartridge.</td>
<td>Restart the printer.  Check that the ink cartridge is installed correctly.  Please contact your Rockwell Automation representative if the error persists.</td>
<td>Only use original ClearMark Advanced ink cartridges.</td>
</tr>
<tr>
<td>60008</td>
<td>Transport timeout</td>
<td>Restart the printer.  Carry out a sensor test.</td>
<td>The marker was not transported within the defined time.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>If the message is displayed again, please contact your Rockwell Automation representative.</td>
</tr>
<tr>
<td>60009</td>
<td>Internal error</td>
<td>Restart the printer.</td>
<td>If the message is displayed again, please contact your Rockwell Automation representative.</td>
</tr>
</tbody>
</table>

Printer faults and damage caused by the use of unapproved and unsuitable accessories and consumables are excluded from the warranty. Furthermore, Rockwell Automation shall not accept any responsibility for the print quality and print resistance if third-party software, markers or inks have been used that have not been approved by Rockwell Automation for this system.
## Specifications and Accessories

### Technical Specifications

<table>
<thead>
<tr>
<th>Technical data</th>
<th>Printing on Rockwell Automation Marker Cards</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Application</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Technology</strong></td>
<td>Ink-jet process with heat curing</td>
</tr>
<tr>
<td><strong>Print quality</strong></td>
<td>600 dpi, 1200 dpi</td>
</tr>
<tr>
<td><strong>Labeling and marking software</strong></td>
<td>ClearTools™</td>
</tr>
<tr>
<td><strong>System requirements</strong></td>
<td>Microsoft® Windows 7, Windows 8, Windows 8.1, Windows 10</td>
</tr>
<tr>
<td><strong>Feed</strong></td>
<td>Automatic loader for max. 30 Marker Cards (for Marker Cards only) Single feed for Marker Cards</td>
</tr>
<tr>
<td><strong>Interface</strong></td>
<td>USB 1.1/2.0</td>
</tr>
<tr>
<td><strong>Voltage supply</strong></td>
<td>AC 100-120 V / 8 A, 50/60 Hz</td>
</tr>
<tr>
<td><strong>Fuses</strong></td>
<td>Right-hand fuse: 10 AHT 240/120V Left-hand fuse: 2.5 AHT 240/120V</td>
</tr>
<tr>
<td><strong>Operating location</strong></td>
<td>Office conditions</td>
</tr>
<tr>
<td><strong>Ambient temperature</strong></td>
<td>10 … 35 °C (50 … 95 °F)</td>
</tr>
<tr>
<td><strong>Dimensions (L x W x H)</strong></td>
<td>Length including output rail: Width: Height with folded down touch panel: Height with folded up touch panel:</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>57.8 kg (127.45 lb) with packaging 37.2 kg (82.01 lb) without packaging</td>
</tr>
<tr>
<td><strong>Ink system</strong></td>
<td>Color system → 1 x black 1 x cyan, 1 x magenta, 1 x yellow</td>
</tr>
<tr>
<td><strong>Scope of supply</strong></td>
<td>• ClearMark™ Advanced • Power cable • USB cable • 1 box of catalog number 1492-MSX5 Marker Cards • Output rail • DVD with the ClearTools software • Quick start guide • Ruler for calibration • The printer is equipped with ink cartridges and the ink collector.</td>
</tr>
</tbody>
</table>
## Accessories

<table>
<thead>
<tr>
<th>Description</th>
<th>Catalog Number</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>ClearMark Advanced</td>
<td>1492-PCMA110</td>
<td>PN-505632</td>
</tr>
<tr>
<td>Black ink cartridge</td>
<td>1492-PCMAINK-K</td>
<td>PN-505636</td>
</tr>
<tr>
<td>Cyan ink cartridge</td>
<td>1492-PCMAINK-C</td>
<td>PN-505634</td>
</tr>
<tr>
<td>Magenta ink cartridge</td>
<td>1492-PCMAINK-M</td>
<td>PN-505637</td>
</tr>
<tr>
<td>Yellow ink cartridge</td>
<td>1492-PCMAINK-Y</td>
<td>PN-505638</td>
</tr>
<tr>
<td>Ink collecting tray</td>
<td>1492-PCMACOLLECT</td>
<td>PN-505640</td>
</tr>
<tr>
<td>100 ml bottle with fluid</td>
<td>1492-PCMAFLUID</td>
<td>PN-505641</td>
</tr>
<tr>
<td>Cleaner tissue</td>
<td>1492-PCMACLEANER</td>
<td>PN-505642</td>
</tr>
<tr>
<td>Service kit</td>
<td>1492-PCMASERVKIT</td>
<td>PN-505643</td>
</tr>
</tbody>
</table>
Rockwell Automation Support

Use the following resources to access support information.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct Dial Codes</td>
<td>Find the Direct Dial Code for your product. Use the code to route your call directly to a technical support engineer.</td>
<td><a href="http://www.rockwellautomation.com/global/support/direct-dial.page">http://www.rockwellautomation.com/global/support/direct-dial.page</a></td>
</tr>
</tbody>
</table>

Documentation Feedback

Your comments will help us serve your documentation needs better. If you have any suggestions on how to improve this document, complete the How Are We Doing? form at http://literature.rockwellautomation.com/idc/groups/literature/documents/du/ra-du002_en-e.pdf.

EEE Yönetmeliğine Uygundur. (In Conformity with the EEE Regulation)

- At the end of its life, this equipment should be collected separately from any unsorted municipal waste.
- This product contains a sealed lithium battery which is permanently connected and should only be removed or replaced by trained professionals.
- At the end of its life, the battery contained in this product should be collected separately from any unsorted municipal waste. The collection and recycling of batteries helps protect the environment and contributes to the conservation of natural resources as valuable materials are recovered.

Battery Notice: This product contains Perchlorate material. Special handling may apply. For more information, go to http://www.dtsc.ca.gov/hazardouswaste/perchlorate/.


Allen-Bradley, ClearMark, ClearTools, Rockwell Automation, and Rockwell Software are trademarks of Rockwell Automation, Inc.
Microsoft and Windows are trademarks of Microsoft Corporation
Trademarks not belonging to Rockwell Automation are property of their respective companies.

Rockwell Otomasyon Ticaret A.Ş., Kar Plaza İş Merkezi E Blok Kat:6 34752 İçerenköy, İstanbul, Tel: +90 (216) 5698400

www.rockwellautomation.com

Power, Control and Information Solutions Headquarters
Americas: Rockwell Automation, 1201 South Second Street, Milwaukee, WI 53204-2496 USA, Tel: (1) 414.382.2000, Fax: (1) 414.382.4444
Europe/Middle East/Africa: Rockwell Automation NV, Pegasus Park, De Kiezelaan 12a, 1831 Dijpegem, Belgium, Tel: (32) 2 663 0600, Fax: (32) 2 663 0640
Asia Pacific: Rockwell Automation, Level 14, Core F, Cyberport 3, 100 Cyberport Road, Hong Kong, Tel: (852) 2887 4788, Fax: (852) 2508 1848

Publication 1492-UM011D-EN-P - February 2020
Supercedes Publication 1492-UM011C-EN-P - October 2019

Copyright © 2020 Rockwell Automation, Inc. All rights reserved. Printed in the U.S.A.